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Learning Outcomes
After studying this chapter, you should be able to
➤
➤
➤
➤
➤
➤
➤

Explain what the term “geospatial technology” means.
Describe the real-world applications of geospatial technology from at least
four different job fields.
Explain the difference between geospatial data and non-spatial data.
Discuss how crowdsourcing and citizen science can be performed with
geospatial technology.
Explain what geolocation is used for.
Describe at least two online resources used for applications of geospatial
technology.
Demonstrate how geospatial data can be viewed using Google Earth.

Have you ever done any of the following?
➤ Used a smartphone, tablet, or other mobile device to find your location
coordinates, get directions, or to look for the nearest restaurant or gas
station?
➤ Used an online mapping service like MapQuest, Google Maps, or Bing
Maps to find directions (and the best route) to a destination or to print
a map of an area?
➤ Used an app to request an Uber vehicle for transportation and viewed
the location of the cars on the app?
➤ Used an in-car navigation system (say, one from Garmin, Magellan, or
TomTom) to navigate to or from a specific location?
1
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➤ Used social media (such as Facebook or Twitter) to add your location
information to a post or tweet?
➤ Used a Global Positioning System (GPS) receiver while hiking, jogging,
hunting, fishing, golfing, or geocaching?
➤ Used a Web resource to find a map of your neighborhood so that you
can compare nearby housing values or see exactly where your property
ends and your neighbor’s begins?
➤ Used a drone to fly over an area and take a photo or video of something
on the ground below it?
➤ Used a virtual globe program (like Google Earth) or an online map to
look at photos or images of your home, street, school, or workplace?
If so, congratulations: You’ve used geospatial technologies. Whenever
you’re using any sort of technology-assisted information (on a computer,
smartphone, or tablet) concerning maps, locations, directions, imagery, or
analysis, you’re putting geospatial technology applications to use.
Geospatial technology has become extremely widespread in society,
with a multitude of uses in both the private and public sectors. However,
more often than not, if you tell someone you’re using geospatial technology,
you’ll be asked, “What’s that?”

geospatial technology a
number of different
high-tech systems that
acquire, analyze, manage,
store, or visualize various
types of location-based data

What Is Geospatial Technology?

geographic information
system (GIS) computerbased mapping, analysis, and
retrieval of location-based
data
remote sensing acquisition
of data and imagery from the
use of satellites or aircraft
satellite imagery digital
images of Earth acquired
by sensors onboard orbiting
spaceborne platforms

Although geospatial technology is being used in numerous fields today, the
term “geospatial technology” doesn’t appear to have seeped into everyday
usage. Terms such as “satellite images” and “Google Earth” and acronyms
such as GIS and GPS are growing increasingly commonplace, yet the phrase
“geospatial technology” seems relatively unknown, even though it incorporates all of these things and more. Geospatial technology describes the use
of a number of different high-tech systems and tools that acquire, analyze,
manage, store, or visualize various types of location-based data. The field of
geospatial technology encompasses several fields and techniques, including:
➤ Geographic information system (GIS): Computer-based mapping,
analysis, and retrieval of location-based data

aerial photography
acquisition of imagery of
the ground taken from an
airborne platform

➤ Remote sensing: Acquisition of data and imagery from the use of satellites (satellite imagery) or aircraft (aerial photography)

Global Positioning System
(GPS) a technology that
uses signals to acquire realtime location information
from a series of satellites in
Earth’s orbit

➤ Global Positioning System (GPS): Acquisition of real-time location
information from a series of satellites in Earth’s orbit
Numerous related fields utilize one or more of these types of technologies. For instance, an in-car navigation system already contains extensive
road-network data, mapped out and ready to use, including information
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about address ranges, speed limits, road connections, and special features
of roads (such as one-way streets). It also requires the mapping of points of
interest (such as gas stations or restaurants) and should be capable of referencing new user-defined destinations. It also has to be able to plot the car’s
real-time position in relation to these maps and may even have a feature
that shows a representation of the surrounding landscape as taken from an
overhead viewpoint. Many of these types of systems combine different geospatial technologies to work together in one application.

Who Uses Geospatial Technology?
Geospatial technology is used in a wide variety of fields ( Figure 1.1),
including federal, state, and local government; forestry; law enforcement;
public health; biology; and environmental studies. (See Hands-On
Application 1.1: Industries Using Geospatial Technology for a look at
industries employing people in these fields.) As long as the job field involves
FIGURE 1.1
Examples of geospatial
technology in action
on the job. [(top left) AP
Images/Wilfredo Lee; (top right)
Ron Nickel/Perspectives/Getty
Images; (center left) Joe Raedle/
Getty Images; (center right) Bob
Nichols/USDA NRCS; (bottom left)
AP Images/Dr. Dan Dzurisin/U.S.
Geological Survey; (bottom right)
Justin Sullivan/Getty Images]

Copyright ©2020 W.H. Freeman Publishers. Distributed by W.H. Freeman Publishers. Not for redistribution.
02_shelligt5e_24951_ch01_001_039.indd 3

12/10/19 1:27 PM

4

Chapter 1

IT’S A GEOSPATIAL WORLD OUT THERE

Hands-On Application 1.1
Industries Using Geospatial Technology
Geospatial technology is being used in a variety
of applications in numerous different fields today.
For a deeper look at some of these applications,
visit www.esri.com/industries , which is run by
Esri. (We’ll discuss Esri further in Chapter 5 , but
the short version is that it is the market leader in
GIS.) This site lists dozens of different fields that
are using geospatial technology and describes
how GIS and other Esri products are being utilized
in them. Examine a few that are connected to your
own fields of interest. For instance, if your interest
is in law enforcement, examine some of the “Public

Safety” category applications. If you’re involved
in environmental science, examine some of the
applications in the “Natural Resources” category.
Then describe how GIS is being utilized in some
real-world, on-the-job applications.

Expansion Questions
➤ How is GIS being utilized in some real-world,
on-the-job applications in fields of interest to
you?
➤ Who in these fields is using GIS with what kinds

of applications, and why are they using GIS?

the utilization of some sort of information or data that has a location associated with it, chances are that some sort of geospatial technology is being
used. Geospatial technology has been heralded by the U.S. Department of
Labor as one of the main emerging and evolving job fields in the United
States, with enormous growth potential. For instance, the Department
of Labor’s O*NET (Occupational Information Network) OnLine utility
contains job descriptions in fields such as “Geospatial Information Scientists
and Technologists,” “Remote Sensing Scientists and Technologists,” and
“Geographic Information Systems Technicians.” (See Hands-On Application
1.2: Jobs in the Geospatial Field for more information about types of jobs.)
The following are just a handful of examples of fields that utilize
geospatial technology.

Hands-On Application 1.2
Jobs in the Geospatial Field
Businesses are hiring in the geospatial field. For
examples of current job openings, visit some of the
following Websites:
1. GeoSearch: https://jobs.geosearch.com/
JobSeeker/Jobs.aspx

These are just a sampling of Websites on which
employers post job openings worldwide. Examine
several jobs from areas near where you are (or
where you’d like to go to).

Expansion Questions

2. GIScareers.com: www.giscareers.com

➤ What kinds of jobs are being advertised?

3. GISjobs.com: www.gisjobs.com

➤ For what kinds of job qualifications, training,

4. The GIS Jobs Clearinghouse: www.gjc.org
5. My GIS Jobs: www.mygisjobs.com

and skill sets are employers looking?
➤ What kinds of starting salary ranges are

employers offering?

Copyright ©2020 W.H. Freeman Publishers. Distributed by W.H. Freeman Publishers. Not for redistribution.
02_shelligt5e_24951_ch01_001_039.indd 4

12/10/19 1:27 PM

5

WHO USES GEOSPATIAL TECHNOLOGY?

Archeology
The ability to pinpoint the location of artifacts uncovered on a dig,
construct a map of the area, and then search for patterns on the site are all
archeological functions that can be rendered quickly and efficiently with
geospatial technology (Figure 1.2). Archeologists can utilize historical
maps, current aerial photography or satellite imagery, and location
information obtained on the site throughout the course of their work.

City Planning
Utilities, wastewater, green space, traffic, roads, zoning, and housing are
all matters of concern to urban planners. Geospatial technology provides a
means of working with all of these entities together for planning purposes.
Strategies for smart urban growth and the management and updating of
city resources can be examined through a variety of different applications.

Environmental Monitoring
Processes that affect Earth’s environment in many different ways can be
tracked and assessed using geospatial technology. Information about landuse change, pollution, air quality, water quality, and global temperature
levels is vital to environmental research, ranging from the monitoring of
harmful algae blooms to studies in climate change (see Figure 1.3).

Forestry
All manner of forest monitoring, management, and protection can be aided
through the use of geospatial technology. Modeling animal habitats and the
pressures placed upon them, examining the spatial dimensions of forest

FIGURE 1.2
Using GIS for mapping
archaeological sites in
London. [Example of GIS and
archeology in London, an online
map created for ‘The archaeology
of Greater London’ © MOLA]
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FIGURE 1.3
Global carbon monoxide
concentrations as
monitored by NASA
remote sensing
satellites. [NASA GSFC
Scientific Visualization Studio,
based on data from MOPITT
(Canadian Space Agency and
University of Toronto)]

fragmentation, and managing fires are among the many different ways that
geospatial technology is utilized within the field of forestry (Figure 1.4).

Homeland Security
Geospatial technology is a key component in examining vulnerable areas
with regard to homeland security. Risk assessment of everything from evacuation plans to smoke-plume modeling can be examined using geospatial
technology. Disaster mitigation and recovery efforts can be greatly enhanced
through the use of current satellite imagery and location-based capabilities.
FIGURE 1.4
Geospatial technology
used for assessing
the risk of wildfires in
Virginia. [Virginia Department
of Forestry]
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FIGURE 1.5
A GIS map showing
crime locations in
Minneapolis.

Law Enforcement
The locations of various crimes can be plotted using GIS. Law enforcement
officials can use this information to analyze patterns (Figure 1.5) and to
determine potential new crime areas. Geospatial technology can be used
in several other ways beyond mapping and analysis; for instance, police
departments can gather high-resolution aerial photography of locations of
patrols to provide further information about potentially dangerous areas.

Health and Human Services
Geospatial technology is used in a variety of health-related services. For
example, geospatial technology applications can be used to monitor diseases, track sources of diseases, and map health-related issues (such as the
spread of H1N1 or other types of influenza; see Figure 1.6).
FIGURE 1.6
A CDC map examining
the spatial distribution of
influenza activity. [CDC/
Centers for Disease Control]
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Military and Intelligence
Geospatial technology plays a key role in today’s military, defense, and intelligence operations. Satellite imagery and aerial photography have long been
used for intelligence gathering and reconnaissance, practices that continue
today with an increased use of unmanned aircraft systems (UAS) and highresolution satellite sensors. The field of geospatial intelligence (GEOINT)
encompasses all types of remotely sensed imagery, GIS, and GPS data for
information gathering and analysis related to national security and defense
applications. In the United States, the National Geospatial-Intelligence Agency
(NGA) is the primary division of the government working with GEOINT.

GEOINT geospatial
intelligence Geospatial
information gathered, used,
and analyzed for military
or government intelligence
purposes

Real Estate

geospatial data items that
are tied to specific real-world
locations

Through geospatial technology, realtors and appraisers (as well as home buyers and sellers) can create and examine maps of neighborhoods and quickly
compare housing prices and values of nearby or similar properties. Other features of a property can be examined by viewing high-resolution aerial images,
which show the topography, the terrain, and even whether it’s located on a
floodplain. You can also examine where a property is located in relation to
schools, highways, wastewater treatment plants, and other urban features.
All of these areas and many, many more are reliant on the capabilities
of geospatial technology. No matter the field, what distinguishes geospatial
technology from other types of computer systems or technologies is that it
explicitly handles geospatial data.

What Is Geospatial Data?
Geospatial data (also often referred to as “spatial data”) refers to
location-based data, which is at the heart of geospatial technology applications. The ability to assign a location to data is what makes geospatial
technology different from other systems. You’re using geospatial concepts
anytime you want to know “where” something is located. For instance,
emergency dispatch systems can determine the location of a call to 911.
They also have access to information that tells them where the local fire
stations, ambulance facilities, and hospitals are. This type of information
allows the closest emergency services to be routed to its location.
When the data you’re using has a location that it can be tied to, you’re
working with geospatial data. This isn’t just limited to point locations;
the length and dimensions of a hiking trail (and the locations of comfort stations along the trail) are examples of real-world data with a spatial
dimension. Other kinds of data, like the boundaries of housing parcels in
a subdivision or a satellite image of the extent of an area impacted by a natural disaster, would fall into this category. Geospatial technology explicitly
handles these types of location-based concepts.
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However, not all of the data in the world is geospatial data. For instance,
data regarding the location of a residential parcel of land containing a house
and the parcel’s dimensions on the ground would be geospatial information.
However, other data, such as the names of the occupants, the assessed value of
the house, and the value of the land is not geospatial information. A benefit of
using geospatial technology is that this type of non-spatial data can be linked
to a location. For instance, say you sell a lot of used books on eBay. You could
make a map showing the locations of each of the purchasers of your online
sales, and this would be geospatial information. You could then link related
non-spatial data (such as the title of the book that was sold or the price it was
purchased for) to those locations to create a basic database of sales.
Geospatial information can also be gathered about other characteristics, such as the landscape, terrain, or land use. Remote sensing provides
images of the ground that serve as “snapshots” of particular locations at specific times, which can generate other forms of spatial information. A variety
of different types of platforms are available to acquire this remotely sensed
information—from high-speed aircraft equipped with special cameras to
unmanned drones flown from the ground by an app on a tablet, to satellites
orbiting hundreds of miles above Earth. (See Figure 1.7 for examples of
these types of remote sensing platforms.)

non-spatial data data
that is not directly linked to a
geospatial location (such as
tabular data)

FIGURE 1.7
Various types of remote
sensing platforms used
for acquiring imagery
of Earth from the sky or
from space. [Midwest Aerial
Photography; NASA’s Goddard
Space Flight Center; SKatzenberger/Shutterstock; WorldView-3
satellite rendering © 2019
Maxar Technologies, courtesy of
DigitalGlobe]
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For instance, a satellite image of Las Vegas, Nevada, can help ascertain
the locations of new housing developments. Examining imagery from several
dates can help track locations where new houses are appearing (Figure 1.8).
Similarly, geospatial technology can be used to determine where, spatially,
new urban developments are most likely to occur by analyzing different
pressures of development on these areas. This kind of imagery can be used
in conjunction with other geospatial data to examine factors such as the
pressure that a growing city in the desert puts on water resources or where
new emergency services need to be situated to provide rapid coverage to
the area.
At the national level, the USGS maintains a large geospatial data distribution program called The National Map. Users of The National Map
can access multiple types of data, including Digital Elevation Models
(see Chapter 13), hydrography (see Chapter 5), transportation (see Chapter 8),
land-cover data (see Chapter 5), orthoimagery (see Chapter 9), boundary

The National Map an
online basemap and data
viewer with downloadable
geospatial data maintained
and operated by the USGS
and part of the National
Geospatial Program

1972

1986

1992

2000

FIGURE 1.8
Satellite imagery (from 1972, 1986, 1992, and 2000) showing the growth of Las Vegas, Nevada, over time.

[USGS]
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files, and many more, all in formats that GIS software can easily read. The
National Map is just one part of the larger coordinated vision that comprises
the National Geospatial Program, and it serves as a source of geospatial data
for the United States. (See Figure 1.9 and Hands-On Application 1.3: The

FIGURE 1.9
The National Map
Viewer. [USGS The National
Map]

Hands-On Application 1.3
The National Map
You can access The National Map online at https://
viewer.nationalmap.gov/basic. A new Web page will
open with the Basic Viewer, the tool for accessing
and downloading GIS data via The National Map.
To begin, first use the Search box and type in an
area of interest (go to Reno, Nevada) and click Go.
The Viewer will shift to a map of your chosen location, and from the Data options on the right-hand
side you can select which geospatial data layers
you’d like to download for that place. For instance,
choose Boundaries—National Boundary Dataset,
and a clickable graphic of the boundaries layer
will appear, and you can download it. Also click on
Hydrography (NHD) and Watersheds (WBM) for similar options. Under the Hydrography options you’ll
be prompted to choose which layer you want—for
instance, click on the HU8 Subbasin—and you’ll

see the water bodies and rivers that you can download appear on the map. Once you’ve chosen the
layers you want, click on Find Products. A set of
downloadable options will appear; click on Results
for each of them, and you’ll find download links
for each dataset. The National Map allows you to
download on demand. If you choose to download,
you’ll receive a zipped file with your data directly
from the Website.

Expansion Questions
➤ Search for your own local area. What products

are available for you to download?
➤ What types of data can be accessed via

The National Map besides boundaries and
hydrography? Why does this make The National
Map so versatile as a one-stop data destination?
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National Map for more information about The National Map.) You can think
of The National Map as a “one-stop-shopping” venue for free geospatial data;
numerous types of datasets are available for the entire United States.
Many types of decision making are reliant on useful geospatial information. For instance, when a new library is proposed to be built in a particular
area, the choice of location is important: The new site should maximize the
number of people who can use it but minimize its impact on other nearby
sites. The same type of geospatial thinking applies to the placement of new
schools, fire stations, and fast-food chain restaurants. Geospatial information fuels other decisions that are location dependent. For instance, historical preservation efforts seek to defend historic Civil War battlefield sites
from urban development. Knowing the location of the sections of land that
are under the greatest development pressure helps in channeling preservation efforts to have the greatest impact. With more and more geospatial
technology applications becoming available, these types of geospatial problems are being taken into consideration. (See Hands-On Application 1.4:
Mapping Data Layers Online; Hands-On Application 1.5: Examining Real
Estate Values Online; and Hands-On Application 1.6: Geospatial Technology
and Crime Mapping for examples.)

Hands-On Application 1.4
Mapping Data Layers Online
Online mapping applications that combine a number
of different types of spatial data into a series of map
layers are becoming increasingly common. A good,
easy-to-use resource for viewing spatial information
online is the Vermont Interactive Map Viewer, a utility for mapping various layers of data about the state
of Vermont. Go to http://maps.vermont.gov/vcgi/
html5viewer. Under the Layers list on the left-hand
side of the Map Viewer, you’ll see multiple options for
various data layers to show on the map; a checkmark
in a layer’s box means it is displayed on the map.
By expanding the options under Base Maps,
you’ll see that you have several options for the
basemap (the initial layer of the map on top of which
other GIS layers will be placed). Also keep in mind
that layers at the top of the list will be drawn on top
of layers at the bottom, so if you place a checkmark
in a layer and it doesn’t appear, make sure a basemap option above it on the list isn’t checked.
Next, zoom in closer to a major city (such as
Burlington) by typing the city name into the Search

box and then choosing from the options that appear
in the table in the lower half of the screen. At a
close-in level, you’ll be able to examine other clickable layers from the map, like contours, boundaries,
facilities, and water resources such as private wells.
In addition, the pull-down menus and buttons at the
top of the screen will allow you to draw on the map
to highlight things, make measurements, or switch
to street-level photography on a road.

Expansion Questions
➤ With the Cached Basemap layer turned on, how

is the city of Burlington represented differently
using the BING Aerial, Lidar Hillshade, and
Topo Basemap (ESRI) layers?
➤ Why are certain layers (such as buildings,

facilities, and landmarks) visible only as you
zoom in closely to areas? Why would they not
be visible when you are zoomed further out to
view a larger area of Vermont?
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Hands-On Application 1.5
Examining Real Estate Values Online
Zillow is an online tool used to examine housing
prices in cities across the United States. You can
examine the prices of houses for sale in any neighborhood and see—spatially—where housing prices
change. In other words, Zillow provides online mapping related to real estate prices and appraisal. To
check it out, visit www.zillow.com. Starting with
the Buy option on the main page, go to the Search
box, and type Virginia Beach, Virginia. On the next
screen a map will appear; zoom in on some of the
residential neighborhoods, and you’ll see markers in blue (auction sites) and red (homes for sale).
Also, under the Listing Type pull-down menu, you’ll
have options to add purple markers (homes for
rent) and yellow markers (recently sold). Selecting a

marker will give you the sale (or sold) price, along
with Zillow’s estimated market value. This tool
allows you to select any location and examine nonspatial information (such as housing prices and
other details) that refers to this location.

Expansion Questions
➤ Use Zillow to check out your own local area.

What does the housing market look like for your
own area (in terms of how many houses are for
sale and, more importantly, whether there are
any patterns or clusters of houses for sale)?
➤ How do the asking prices of the houses for sale

compare with their estimated values?

Hands-On Application 1.6
Geospatial Technology and Crime Mapping
Geospatial technologies are used in many applications related to emergency services, criminal justice,
police procedures, and law enforcement. An example of using geospatial technology with mapping of
crime locations is available online at https://www
.crimemapping.com . On the Website, you’ll be
able to search for crime activity near a location or
near an agency in a state. Note that not all locations will have reported crime data for them. To get
started, under Near a Location, type the zip code
for San Diego, California: 92101. The crime mapper will open with a map full of icons showing various types of crimes. By clicking on an icon, you’ll
receive the attribute information about that crime
in a side panel, including the date, time, and type
of crime. If there is an icon with a number, that

indicates multiple crimes at that location; the side
panel will have an arrow to click on that allows you
to see all the various crime records for that location.

Expansion Questions
➤ On the San Diego map, look for Petco Park

(the home of the MLB San Diego Padres). What
types of crimes have been recently committed
near the park, and how many of each type?
➤ Use the Website to look at your own local area.

Are reported crimes available in your own local
area? If they are not available, why is this the
case? If CrimeMapping is reporting crimes in
your own locale, what types of crimes are most
prevalent?
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What Does All This Have to Do with
Geography?
The first sentence for the entry “geography” in The Dictionary of Human
Geography describes geography as “the study of the Earth’s surface as the
space within which the human population lives.” To simplify a definition
further into words of one syllable, geography is not just “where things are”
but the study of “why things are where they are.” Geography deals with concepts of the spatial characteristics of our planet and the spatial relationships
and interactions of the people and features that occupy it. The notion of
“geographic information science” has been around for years as the study of
the multiple concepts that surround the handling of spatial data, and today
the use of geospatial technologies is tightly interwoven with the discipline
of geography. See Hands-On Application 1.7: The Geospatial Revolution Will
Be Televised for several examples of geospatial technologies being used for
solving geographic problems.
At the higher education level, courses in GIS, remote sensing, GPS, and
various applications of these technologies are key components of a geography curriculum. Certificate programs in geographic information science
(GISci) or geospatial technologies are increasingly being offered by colleges
and universities. Geospatial degree programs at the bachelor’s, master’s, and
doctoral levels have been developed at numerous universities. (See Chapter
15 for more information about geospatial technology in education.) Even
in basic activities such as collecting data in the field for a class project or
producing a map of results, geospatial technologies have become an integral
part of the geography discipline.
In a 2004 article, Jack Dangermond, CEO of the Environmental Systems Research Institute, Inc. (Esri; see Chapter 5), heralded GIS as a way

Hands-On Application 1.7
The Geospatial Revolution Will Be Televised
Penn State University’s Geospatial Revolution Project showcases a series of excellent videos that
detail how geospatial technology affects our everyday lives, especially when it comes to concerns
such as monitoring climate change and tracking
disease. Visit http://geospatialrevolution.psu.edu
and watch the available videos. There are additional
videos aimed at a K–12 audience (but that also
present relevant information for all education levels)
in the For Educators section.

Expansion Questions
➤ How can geospatial technologies be used to
aid in monitoring climate change conditions?
➤ How have geospatial technologies helped aid

workers in dealing with food shortages or in
mitigating the effects of disease outbreaks?
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of “speaking the language of geography,” and in a 2009 article, he noted
that GIS is “geography in action.” Both of these are great descriptions; for
example, when you use an in-vehicle navigation system to navigate through
unfamiliar territory or use an online tool to examine housing values for
your neighborhood, you’re using basic geographic concepts of space and
place through technology. Geospatial technology gives us the tools to apply
location-based principles to real-world situations more easily. For example, how is the new freeway bypass going to affect the local community in
regard to traffic flow, new commercial development, and individual properties? Or, what are the potential impacts of the site chosen for a new casino
development in relation to land use, economic and social effects, and the
draw of gamers from far outside the local area? Throughout this book,
you’ll be working with geospatial technology concepts and applications,
using geospatial data, measuring spatial characteristics, and examining spatial relations.
One of the most welcome recent developments is the opportunity for
people without geospatial training to get involved in this field by applying
their geographic knowledge. With geospatial tools becoming more widely
utilized, people now have the chance to create their own geospatial content.
Whether they’re creating new maps, updating existing maps, tying digital
pictures to locations on a map, or adding to geocaching databases, more
and more people are using geospatial technologies to add to or enhance
geospatial data and knowledge. Dr. Michael Goodchild coined the term
“volunteered geographic information” (VGI) to give a name to data generated in this way.
A wiki is a Web utility that allows users to create, manage, update,
and change the content of a Website freely. Possibly the best known wiki
is Wikipedia, an online encyclopedia that anyone can edit. The wiki concept has been extended to geospatial data, and individuals can contribute
their own maps, images, and updates to geospatial content available on the
Internet, thereby generating VGI. Online projects such as The National
Map Corps or OpenStreetMap (see Figure 1.10 and Hands-On Application
1.8: User-Generated Geospatial Content Online for more information) allow
users to generate or contribute geospatial content as volunteered geographic
information.
For example, Google Maps allows users to contribute to the content of
the Website by adding places, locations, and hiking trails or by helping to
improve directions given by the system. Similarly, the USGS has established
The National Map Corps to allow users to make edits and updates to the
data of The National Map. After all, who would know more than you about
new businesses that have opened, new roads that have been put in, or local
hiking trails in your area? By contributing your geographic knowledge to
sources such as OpenStreetMap, you’re helping to build an extensive database of geospatial content as well as improving available online resources
used by others.

15

VGI volunteered geographic
information; a term used
to describe user-generated
geospatial content and data
wiki a database available for
everyone to utilize and edit
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FIGURE 1.10
Detroit, Michigan,
and Windsor,
Canada, as shown in
OpenStreetMap.

It’s becoming easier to apply geographic principles using geospatial
technologies. For instance, on May 4, 2012, the Saugerties Times published
a call for volunteers to take part in the launch of a free smartphone app
for mapping the spread of invasive species and explained that the collected
data would be utilized in a New York invasive species database. In activities

Hands-On Application 1.8
User-Generated Geospatial Content Online
Volunteered geographic information (VGI) represents user-generated geospatial content online.
Use your Web browser to investigate some of these
sites and see how your own local area is represented with each one:
➤ OpenStreetMap: www.openstreetmap.org
➤ The National Map Corps: https://edits

.nationalmap.gov/tnmcorps
➤ Wikimapia: www.wikimapia.org

In addition, check out the Humanitarian OpenStreetMap Team Website, at www.hotosm.org. This
group uses OpenStreetMap capabilities to edit the
maps for a number of different projects, such as
mapping populated places in Africa and South Asia
as part of an effort to combat malaria.

Expansion Questions
➤ From examining your local area on
OpenStreetMap, Wikimapia, and The National
Map Corps Websites, what kinds of things
could you potentially update or add using your
own local geographic knowledge? Have any of
these additions or updates already been made
to one site but not another?
➤ What types of current projects are ongoing

with the Humanitarian OpenStreetMap Team
Website, and how can you contribute to them
with your own geospatial content?
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such as these, referred to as crowdsourcing, untrained volunteers collect
data, content, or observations as part of a larger project (often referred to as
citizen science). The GLOBE project (see Chapter 15) is an example of
citizen science in action; everyday people are collecting pictures on their
smartphones, identifying the kind of land cover they’re looking at, and
uploading this information to GLOBE, which uses it for ground reference data in relation to satellite imagery. In geospatial terms, crowdsourcing allow huge numbers of people to contribute VGI to ongoing projects.
Geospatial technologies are enabling everyone to become involved with
collecting and analyzing geographic data. In particular, as mobile technologies and smartphones become more and more widespread, geospatial technology applications are ending up, quite literally, in the palm of your hand.
Numerous apps use geospatial technologies, and a technique called geolocation lies at the heart of many of them.

crowdsourcing the
activities of untrained
volunteers to create content
and resources that can be
utilized by others
citizen science the
activities of untrained
volunteers conducting
science

What Is Geolocation?
Geolocation is the technique of determining where something is in the
real world. By using geolocation, your smartphone, tablet, laptop, or desktop computer can determine what its current location is, give you the coordinates (such as latitude and longitude; see Chapter 2), and then plot that
information on a map. This position can be found in several different ways—
by using the IP address of your computer, your Wi-Fi connection, the cell
towers your phone’s signal is pinging off, or the GPS receiver in your mobile
device. Of course, once your phone, tablet, or computer knows where it is, it
can share that location information with others via the Internet.
For instance, Websites often ask you if they can use your location.
When you use a Website such as fandango.com to look up movie times or
chilis.com to find information about a Chili’s restaurant, these Websites ask
if they can use your computer’s location. If you agree to share your location,
you will receive information about movie theaters nearby or address information about the Chili’s closest to you. Websites such as these can leverage
knowledge about where you are (i.e., geolocation) to provide services to you
based on your location. This is done through the W3C Geolocation API, a
set of commands and techniques used by programmers to obtain the location information of your phone, tablet, or computer. (See Chapter 15 for
more about APIs.) Basically, with a few lines of computer code, a Web or app
developer can use geolocation to determine where your computer or mobile
device is and in turn use that location in its services. For an example of geolocation in action, see Hands-On Application 1.9: Where Am I Right Now?
Often an app or device gives you the ability to geotag your media
(such as a photo) by assigning your location to it through geolocation. For
instance, when you take a photo with your phone, you may have the ability

geolocation the technique
of determining where
something is in the real world

W3C Geolocation API the
commands and techniques
used in programming to
obtain the geolocation of a
computer or mobile device

geotag to connect realworld location information to
an item
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FIGURE 1.11
Geotagged tweets of “Je suis Charlie” sent in the aftermath of the terrorist attacks on the Charlie Hebdo newspaper
on January 7, 2015.

to include the location information of where you took the photo. Thus, you
can connect the photos to their locations on a map. This use of geolocation
is becoming a large component of social media as well. Whenever you use
the Facebook app on your smartphone to make a post or send a tweet with
the Twitter app, you have the option of adding your current location to that
post or tweet. Geotagged tweets can then be mapped to see the locations
from which people are sending tweets.
For instance, in the aftermath of the January 7, 2015, terrorist attack
on the offices of the Charlie Hebdo newspaper in Paris, people worldwide
tweeted “Je suis Charlie” (which is French for “I am Charlie”) to show support for the murdered journalists. Because many of the people sending the
tweets included their location information with the tweet, those locations
can be mapped. Figure 1.11 shows an example of these worldwide geotagged “Je suis Charlie” tweets.
Through geolocation, a mobile device can know where it is. The Find
My iPhone service uses geolocation to track your iPhone or iPad and displays its location on a map. Geolocation fuels many other common applications used on mobile devices today. For instance, the popular Yelp app
allows users to see nearby restaurants’ locations and read (or write) reviews
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Hands-On Application 1.9
Where Am I Right Now?
To see the W3C Geolocation API in action, go to
http://whereamirightnow.com. When prompted by
your browser, indicate that you will allow your location to be shared with the Website. Give it a few
seconds, and the Website will display a map of your
current location (as determined using the W3C Geolocation API). This feature also works on the Web
browser on a smartphone or tablet.

Expansion Questions
➤ What kind of information did the Website
display about your current location?
➤ How accurate was the Website in identifying

where you were using the W3C Geolocation
API? What methods did geolocation use to find
you?

for them. The Foursquare City Guide app works in a similar way: It collects
crowdsourced information about restaurants, shopping, and nightlife from
users and can provide that information to you for places near your location.
The Foursquare Swarm app allows users to share their locations with others
(referred to as “check ins”) at different venues, such as shops or clubs. Even
online dating uses geolocation; the popular Tinder app shows you how far
away other users of the dating site are from your location. Beyond geolocation, there are many other geospatial technology apps available today; a
widely used example is Google Earth.

What Is Google Earth?
An example of a widespread geospatial technology application is the popular Google Earth software program. Google Earth is a virtual globe—a
program that provides an interactive three-dimensional (3D) representation of Earth. Google Earth brings together several aspects of geospatial
technology into one easy-to-use program. You can examine satellite imagery or aerial photography of the entire globe, zoom from Earth’s orbit to
a single street address, navigate through 3D cities or landscapes, measure
global distances, and examine multiple layers of spatial data together, all
with an intuitive interface.
Google Earth was first launched in 2005, but in 2017 Google significantly revised its groundbreaking yet aging software. If you want to put the
software onto your computer and use multiple layers and various analytical
features, you can freely download Google Earth Pro (which we use in several Geospatial Lab Applications in this book; see Figure 1.12 for an example of Google Earth Pro’s layout). However, Google Earth itself now doesn’t
need to be downloaded and installed on a computer. Instead, Google Earth
can now run in a Web browser or as an app on a smartphone or tablet, and

Google Earth a freely
available virtual globe
program first released in
2005 by Google
virtual globe a software
program that provides an
interactive three-dimensional
map of Earth
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FIGURE 1.12
A view of downtown Boston, Massachusetts, from
Google Earth Pro.

it allows you to tour the world, viewing satellite imagery and 3D visualizations around the globe (see Figure 1.13).
Both the Pro version for your computer and the regular browser version
of Google Earth rely on a high-speed Internet connection to send the data
from Google servers to your computer. For instance, when you use Google

FIGURE 1.13
The Google Earth app
running on a tablet. [Iain
Masterton/Alamy Stock Photo]
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Earth to fly from space to your house, the imagery you see on the screen is
being streamed across the Internet to you. The imagery on Google Earth
is “canned”—that’s to say, it’s fixed from one moment in time rather than
being a live view. For instance, if the imagery of your house used by Google was obtained in 2019, then that’s the snapshot in time you’ll be viewing
rather than a current image of your house. However, Google Earth Pro has
a feature that enables you to examine past images. For instance, if imagery
of your town was available in 2010, 2015, and today, you can choose which
of these images you want to view.
Both the browser version and the desktop Pro versions of Google Earth
allow you to add new data as well. Overlays and objects such as satellite
imagery (see Chapter 12) or 3D models (see Chapter 14) can be added as
user content to Google Earth if they are in the Keyhole Markup Language
(KML) format. Google Earth can also work with the compressed version
of KML called KMZ. In this way, a satellite image of a recent event (such
as a hurricane) can be made available in KML format and users can add it
directly to Google Earth.
Geospatial Lab Application 1.1: Introduction to Geospatial Concepts and
Google Earth Pro at the end of this chapter walks you through several different ways of utilizing Google Earth Pro. It assumes no prior experience
with Google Earth Pro, but even veteran users may find some new tricks or
twists in how geospatial data is handled. You’ll use a variety of Google Earth
Pro tools to investigate several of the avenues this book explores, from aerial
image interpretation and 3D representations of terrain and objects to ways
of determining the shortest path between two locations.

KML Keyhole Markup
Language; the file format
used for Google Earth data
KMZ the compressed
version of a KML file

Thinking Critically with Geospatial Technology 1.1
What Happens to Privacy in a Geospatial World?
Think about this scenario: If you own property (a
house or a business), then that information is part of
the public record with the county assessor’s office
and likely available online. Someone can type your
address into an online GIS (or mapping Website
such as MapQuest or Google Maps) and get a map
showing how to travel to your property. In addition,
the dimensions, boundaries, and a high-resolution
image of your property can be obtained easily. It is
possible that other information can be acquired, such

as a close-up photo of your house taken from the
street, and accessed directly from the Website. All of
this is free, publicly available information that can be
obtained with just a few clicks of a mouse. Anonymity about where you live or work is becoming a thing
of the past. What does the widespread availability
(and access to) this type of spatial information mean
with regard to privacy? If anyone with an Internet
connection can obtain a detailed image of the house
you live in, has your personal privacy been invaded?
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Chapter Wrap-Up
So what are you waiting for? Move on to this chapter’s lab (see Geospatial
Lab Application 1.1: Introduction to Geospatial Concepts and Google Earth
Pro) and start getting to work. This chapter’s lab will have you doing all
sorts of things with Google Earth Pro while touching on ideas that will be
explored in every chapter of this book. There are also questions throughout
the lab for you to answer, based on the tasks you’ll be doing. Also, check
out the Geospatial Apps box for a sample of downloadable apps (including
a Google Earth app) for your mobile device. For further ways to get connected with geospatial technology applications through blogs, Facebook,
Twitter, and YouTube, check out the options in Geospatial Technologies in
Social Media.
Important note: The references for this chapter are part of the online companion for this book and can be found at https://www.macmillanlearning
.com/college/us/product/Introduction-to-Geospatial-Technologies
/p/1319249515.

Geospatial Apps
Here’s a sampling of available representative geospatial technology apps
for your smartphone or tablet. Note that some apps are for Android, some
are for Apple iOS, and some may be available for both.
➤ 3D Geo Globe: An app that can determine your coordinates and plot
them on a map of Earth
➤ Field Photo: An app that allows you to take photos with your smartphone’s camera, geotag them, and upload them to a crowdsourced
database for use in environmental studies
➤ Foursquare City Guide: An app that provides information on restaurants, shopping, and nightlife near your location
➤ Foursquare Swarm: An app that allows you to “check in” your location with your smartphone and share that information with others
➤ Google Earth: An app that allows you to use Google Earth on your
mobile device
➤ ViewRanger: An outdoor app that allows you to view your location
on a variety of different maps
➤ Where Am I At?: An app that determines where you are and shows
your location on a map
➤ Yelp: An app for locating restaurants near your location and showing
reviews of them
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➤
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You Need a Map: An app that displays several different types of maps
and map layers and uses your location for detailed geospatial mapping
Zillow Real Estate: An app that allows you to view maps and information about homes for sale

Geospatial Technologies in Social Media
Here’s a sampling of some representative Facebook and Twitter accounts,
along with some YouTube videos and blogs related to this chapter’s
concepts.
On Facebook, check out the following:
➤
➤
➤
➤
➤

GeoAwesomeness: @GeoAwesomeness
Google Maps: @GoogleMaps
Humanitarian Open Street Map: @hotosm
OpenStreetMap: @OpenStreetMap
Wikimapia: @wikimapia
Become a Twitter follower of:

➤
➤
➤
➤
➤
➤
➤
➤
➤
➤

Directions Magazine (geospatial news magazine): @directionsmag
GeoAwesomeness (location-based news): @geoawesomeness
GeoNe.ws: @Geone_ws
GIS and Science: @GISandScience
GIS GeoTech News: @gisuser
Google Earth: @googleearth
Humanitarian Open Street Map: @HOTOSM
MondeGeospatial: @MondeGeospatial
National Geospatial-Intelligence Agency: @NGA_GEOINT
OpenStreetMap: @Openstreetmap
Become an Instagram follower of:

➤
➤

GeoAwesomeness: @geoawesomeness
OpenStreetMap: @openstreetmap
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On YouTube, watch the following videos:
➤

➤

➤

➤

➤

Humanitarian OpenStreetMap Team (a video about the HOTOSM
project): www.youtube.com/watch?v=8wdzGKmZu-k
Interning at NGA (a video about working as an intern at the U.S.
National Geospatial-Intelligence Agency): www.youtube.com/
watch?v=neNS4Im0VvY
Introduction to The National Map (a USGS video about The
National Map): www.youtube.com/watch?v=ISzUlINbB4o
Jobs in Geography (a video sponsored by the Association of American Geographers): www.youtube.com/watch?v=mJz0YTHvCY8
Weird Earth: Overview (a video of some weird and wonderful places
around the planet, as seen by geospatial technologies): www.youtube
.com/watch?v=DDfSxMCof2w

For further up-to-date info, read up on these blogs and news sites:
➤

➤

➤

Citizen Science Blog (a U.S. government source for citizen science
initiatives): https://www.citizenscience.gov/blog
Directions Magazine (an online geospatial news source):
www.directionsmag.com
The Google Earth Blog (a blog about Google Earth and its applications): www.gearthblog.com

Key Terms
aerial photography (p. 2)
citizen science (p. 17)
crowdsourcing (p. 17)
geographic information system
(GIS) (p. 2)
GEOINT (p. 8)
geospatial data (p. 8)
geospatial technology (p. 2)
geolocation (p. 17)
geotag (p. 17)
Google Earth (p. 19)
Global Positioning System (GPS)
(p. 2)

KML (p. 21)
KMZ (p. 21)
The National Map (p. 10)
non-spatial data (p. 9)
remote sensing (p. 2)
satellite imagery (p. 2)
VGI (p. 15)
virtual globe (p. 19)
wiki (p. 15)
W3C Geolocation API (p. 17)
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1.1 Geospatial Lab Application
Introduction to Geospatial Concepts and
Google Earth Pro
This chapter’s Geospatial Lab Application introduces you to some basic
concepts of geospatial technology through the use of the Google Earth Pro
software program. This lab also provides an introduction on how to use
Google Earth Pro and will help familiarize you with many of its features.
Although the Geospatial Lab Applications in later chapters will use a variety of software packages, you’ll also be using Google Earth Pro in many
of them. The investigations in this introductory lab may seem pretty basic,
but labs in later chapters will be more in-depth and will build on concepts
learned here.

Objectives
The goals for you to take away from this lab:
➤ Familiarize yourself with the Google Earth Pro (GEP) environment,
basic functionality, and navigation using the software
➤ Use different GEP layers and features

Using Geospatial Technologies
The concepts you’ll be working with in this lab are used in a variety of realworld applications, including the following:
➤ Cable and network news, which frequently incorporate Google Earth
imagery or flyovers into news segments to show areas of interest, to
demonstrate the spatial relationships or distances between cities visually, or to make visual links between locations of news items
➤ K–12 teachers, who utilize Google Earth imagery (overhead views, 3D
models, flyovers, or directions) to help illustrate a variety of concepts in
class, including geography, history, and science

Obtaining Software
The current version of Google Earth Pro (7.3) is available for free download
at https://www.google.com/earth/versions/. You’ll be using Google Earth
Pro instead of the regular Google Earth in this lab (and others in the book)
to take advantage of its many additional features.
25
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[Sacramento Bee Bryan Patrick/ZUMA Press, Inc./Alamy]

Important note: Software and online resources sometimes change
fast. This lab was designed with the most recently available version of the
software at the time of writing. However, if the software or Websites have
changed significantly between the time this book was published and when
you’re reading it, you can find an updated version of this lab (using the
newest software) online at https://www.macmillanlearning.com/college
/us/product/Introduction-to-Geospatial-Technologies/p/1319249515.

Lab Data
There is no data to copy in this lab. All data comes as part of the GEP data
that is installed with the software or is streamed across the Internet when
using GEP.

Localizing This Lab
Although this lab visits popular locations in a tour around South Dakota,
the techniques it uses can easily be adapted to any locale. Rather than use
GEP imagery and features of South Dakota, find nearby landmarks or popular spots and use GEP to tour your local area.

1.1 Starting to Use Google Earth Pro (GEP)
1. Start Google Earth Pro. (The default install folder is called Google
Earth Pro.) GEP usually opens with a startup tip box, which you can
close. Also, make sure the GEP window is maximized, or else some
features may not show up properly.

Copyright ©2020 W.H. Freeman Publishers. Distributed by W.H. Freeman Publishers. Not for redistribution.
02_shelligt5e_24951_ch01_001_039.indd 26

12/10/19 1:27 PM

1.1 GEOSPATIAL LAB APPLICATION

27

Search box

Places box

Layers box

A popular use of GEP is to view the ground (whether physical landscapes or
structures) from above by using the aerial photography or satellite imagery
streamed in from Google’s servers. The Search box is used for this.
2. In the Search box, type in Mitchell, SD. Next, click on the Search
button.
3. GEP rotates and zooms the view down to eastern South Dakota. One
of the popular attractions in Mitchell is the Corn Palace, a historic
building of fanciful design that now serves as a civic arena, presenting
cultural and sports events and attracting the attention of millions each
August when the murals that cover the building’s façade (which are
completely constructed from corn) are reconfigured to illustrate the
theme of that year’s Corn Palace Festival. More information about the
Corn Palace is available at https://cornpalace.com.
4. In the Layers box, place a checkmark next to Photos. This enables
linking of locations on the ground to photos that users have taken.
The locations that have linked photos have small blue and brown circles over the imagery. You’ll see numerous photo locations clustered
together in one place; that would be the Corn Palace. Click on the
photo symbols on the imagery to see some photos (taken from the
ground) of the Corn Palace.
5. In GEP, you can rotate and zoom your view to get a closer look at the
imagery on the ground. Move the mouse to the upper-right side of the
screen, and a set of controls appears. These controls fade out when not
in use and reappear when the mouse rolls over them.
6. There are five controls. The first one (the ring with the N at the top)
allows you to change the direction you’re facing. Grab the N with the
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7.

8.
9.

10.

11.

12.

mouse (by placing the pointer on N and holding down the left mouse
button) and drag the N (that is, slowly rotate it) around the ring (this
is commonly called “grab and drag”). You see the view change (north
will still be the direction in which the N is pointed). Clicking on the N
returns the imagery so that the north direction is facing the top of the
screen.
The second control is the Look control (the arrows surrounding the
eye). By selecting one of the directional arrows and clicking it with the
mouse, you can tilt your view around the terrain as if you were standing still and looking about. You can also grab the control and move it
(by holding down the left button on your mouse) to simulate looking
around in various directions.
The third control is the Move control (the arrows surrounding the
hand). By grabbing this control, you can pan around the imagery in
whichever direction you choose.
The fourth control is the Street View icon (the yellow figure of a
human—referred to as the “pegman”—standing on a green circle). This
icon appears when Google Street View imagery is available to see on
the ground. We’ll spend more time on Google Street View in Chapter
8, as it’s a utility that allows you to see what places look like as if you
were standing on the street in front of them. To use Street View, you
would grab the icon with the mouse and drag it to a street that’s visible
in the view to enter the Street View mode. This control is visible only
if there are streets in the view through which you can enter Street View
mode (which is why you don’t initially see it when you start GEP and
are looking at the entire planet).
The last control is the Zoom Slider. By pushing forward (moving the
bar toward the plus sign), you zoom in, and by pulling backward (moving the bar toward the minus sign), you zoom out. By default, when
GEP zooms in, it tilts the terrain to give you a perspective view rather
than looking from the top directly down. To always use the top-down
option rather than tilting the ground when zooming, select the Tools
pull-down menu and choose Options. In the dialog box that appears,
click on the Navigation tab and then select the radio button that says
Do not automatically tilt when zooming. To have GEP tilt while
zooming, select one of the other radio buttons.
You can also use the mouse for navigating around GEP. Grab the imagery and drag it to sweep across the map. To zoom in and out, roll the
mouse wheel back and forth. Pan and zoom over to the location of the
Corn Palace. To confirm that you’re in the right place, type the address
of the Corn Palace into the Search box as follows: 604 North Main
Street, Mitchell, SD 57301. GEP automatically adjusts to that location.
For now, turn off the Photos options by removing the checkmark from
the box.
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13. Zoom in on the Corn Palace so that it fills most of the view and you
can make out some details about it.
14. Grab the Street View icon from the controls and drag it to the street
right in front of the Corn Palace. You’ll see the street turn blue (which
indicates that Street View imagery is available for this street). Release
the icon on the street, and the view shifts from an aerial view to imagery that looks like you’re actually standing on Main Street in front of
the Corn Palace.

Place the
icon here

Grab this Street
View icon

15. In Street View, use the mouse to pan around the image (you can see 360
degrees around your position) until you can see the entrance of the Corn
Palace. You can pan and zoom with the mouse as necessary (and also
click on the road—or elsewhere in the image—to advance your view).
16. Examine the Corn Palace and its surrounding area. Then answer Question 1.1. To return to the aerial view, click on the Exit Street View text
in the upper-right corner of the Street View.
Question 1.1 From viewing the Corn Palace from above and in
front, what details from the aerial view can help identify just what
the building is? (You may need to switch back and forth between
the aerial view and the street view to answer this question.)

17. When dealing with remotely sensed imagery, it’s important to consider
that you’re viewing the ground from above and that many features you
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can view from a street level are difficult to perceive from an aerial view.
Chapter 9 delves further into interpreting aerial images and offers
some strategies and tips for doing so, while Chapter 10 deals with how
this type of remotely sensed imagery is acquired. Chapters 11 and 12
explore the acquisition of imagery from various satellites.
18. Here’s another way of looking at the Corn Palace—a 3D representation.
From the GEP Layers options, select 3D Buildings. A 3D representation of the Corn Palace appears on top of the imagery of the building.
Use the zoom and tilt controls and navigate around the building to get
a better look at the 3D model of the Corn Palace, including its façade
and turrets. If the 3D model of the Corn Palace doesn’t appear, select
the Tools pull-down menu, select Options, and select the 3D View tab
and make sure a checkmark is not in the Use 3D imagery (disable to
use legacy 3D buildings) box.
19. After viewing the 3D model of the Corn Palace, turn off the option
for 3D Buildings when you’re done. There are numerous buildings
and objects that have 3D representations designed for use in GEP. In
Chapter 14, you’ll investigate more about working with 3D versions
of geospatial data, as well as constructing your own 3D buildings and
viewing them in GEP.

1.2 Finding Your Way Around with Google
Earth Pro
1. From the Layers box, turn on the Roads layer. You’ll see major roads
(interstates, state highways) identifiable as their labels appear, and local
roads will also be identifiable when you zoom in close.
2. We’re going to leave the Corn Palace behind and continue west
through South Dakota to Wall Drug, a famous tourist location. More
information on Wall Drug can be found at www.walldrug.com.
3. In the Search box, click on the Get Directions option.
4. In the A option (this is where you’re traveling from), type in the Corn
Palace’s address as follows: 604 N Main St, Mitchell, SD 57301.
5. In the B option (this is where you’re traveling to), type in Wall Drug’s
address as follows: 510 Main Street, Wall, SD 57790.
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6. Click the Get Directions button. GEP zooms out to show you the path
(in purple) it has calculated for driving distance between the Corn Palace and Wall Drug, and the Search box fills with directions featuring
stops and turns along the way.
Question 1.2 By viewing the expanse of South Dakota between
Mitchell and Wall, you’ll realize there are many possible routes
between the two. Why do you suppose GEP chose this particular
route to go from the Corn Palace to Wall Drug?
Question 1.3 Based on the route that GEP calculated, what is the
driving distance (and approximate time equivalent) to get from the
Corn Palace to Wall Drug?

7. These capabilities to take a bunch of letters and numbers and turn
them into a mapped location and to calculate the shortest driving distance between points are further developed in Chapter 8. Matching
addresses and calculating shortest routes are key reasons for utilizing
geospatial technologies, and the Chapter 8 lab will go into more depth
on how these types of operations are performed.
8. In the Search box, scroll down through the list of directions and click
on the Wall Drug address next to B. Google Earth zooms to Wall
Drug’s location. Click the X at the bottom of the Search box to clear
the directions and remove the route.

1.3 Using Google Earth Pro to Examine
Landscapes
1. There’s a lot more to the South Dakota landscape than tourist attractions. Wall Drug is located in the town of Wall, which is named for the
line of magnificent land formations nearby and lies directly adjacent
to Badlands National Park. The Badlands are located to the south and
southwest of Wall. For more information about the Badlands, visit
www.nps.gov/badl/index.htm.
2. To see the boundaries of Badlands National Park in Google Earth Pro,
go to the Layers box and expand the option for More (click on the
triangle to the left of the name). In the options that appear under the
expanded heading, put a checkmark in the Parks/Recreation Areas
option. Zoom out from the boundaries of Wall, and to the south you
see the northernmost boundary of Badlands National Park highlighted
in green.
3. Zoom out so that you can see the entire park in the view. New icons for
the locations of Visitors Centers and other features also appear.

Copyright ©2020 W.H. Freeman Publishers. Distributed by W.H. Freeman Publishers. Not for redistribution.
02_shelligt5e_24951_ch01_001_039.indd 31

12/10/19 1:27 PM

32

Chapter 1

IT’S A GEOSPATIAL WORLD OUT THERE

4. Pan over to the eastern edge of the park, and you see a large Question
Mark icon indicating a park entrance as well as a green arrow indicating an overlook.

Overlook

5. Make sure that the option for Terrain in the Layers box is turned on.
Zoom in very closely to the point representing the overlook. At the
bottom of the view you see numbers representing the latitude and longitude of the point, as well as the real-world elevation of that spot.
Question 1.4 What is the elevation of this particular overlook in
Badlands National Park?

6. The imagery in GEP is placed on top of a model of Earth’s vast array of
terrains and landscapes (hills, valleys, ridges, and so on). It’s very difficult to make out the pseudo-three-dimensional (3D) nature of the terrain model from above, so use the Zoom Slider to tilt the view down
(you can also hold down the Ctrl key and move the mouse to help
change your perspective) so that you can look around as if you were
standing at the overlook point (in a perspective view of the planet).
Once you’ve tilted all the way down, use the Look controls to examine
the landscape. From here, use the Move controls to fly over the Badlands from this overlook point. When you’re done cruising around the
Badlands, answer Question 1.5.
Question 1.5 How does the terrain modeling (with the tilt function) aid in the visualization of the Badlands?
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7. This ability to model the peaks and valleys of the landscape with aerial
imagery “draped” or “stretched” over the terrain for a more realistic
appearance is often used with many aspects of geospatial technology.
Chapter 13 greatly expands on this by getting into how this is actually
performed as well as doing some hands-on terrain analysis.

1.4 Using Google Earth Pro to Save Imagery
It’s time to continue to the next leg of our South Dakota journey by heading to Mount Rushmore. Carved out of the side of a mountain in the Black
Hills, Mount Rushmore National Memorial features the faces of presidents
George Washington, Thomas Jefferson, Theodore Roosevelt, and Abraham
Lincoln. For more information about Mount Rushmore, visit www.nps
.gov/moru/index.htm.
1. In GEP’s Search box, type Mount Rushmore. GEP zooms around to
an overhead view of the monument. Like the Badlands, Mount Rushmore is overseen by the National Park Service. Zoom out a little bit
and you’ll see the extent of the memorial’s boundaries (still outlined in
green).
2. You can also save an image of what’s being shown in the view. GEP
can take a “snapshot” and save it as a JPEG graphic file (.jpg), which is
like a digital camera picture. Position the view to see the full outlined
extent of Mount Rushmore, select the File pull-down menu, then
select Save, and finally select Save Image. You’ll see that a box called
Untitled Map has been added; click on that to give your image a name
(like “Mount Rushmore”) and then click on the Save Image... button
at the top of the screen. Name the image moru (GEP will automatically
add the .jpg file extension), and save it to your computer’s hard drive.
3. Minimize GEP for now and go to the location on your computer where
you saved the image and then open it to examine it (using a simple
program such as Microsoft Office Picture Manager).
Question 1.6 Note that even though the graphic contains the
locations of Mount Rushmore, the outline of the park, and information concerning location (including latitude, longitude, and
elevation) at the bottom, it doesn’t have any spatial reference for
measurements. Why is this?

4. Close the image and return to Google Earth Pro. Even though the
saved image doesn’t have any spatial reference, Chapter 3 describes
how to transform unreferenced imagery (and other unreferenced
data) to match referenced data. In Chapter 3’s lab, you’ll do this in a
hands-on fashion. You can also turn off the Parks/Recreation layer
for now.
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1.5 Using Google Earth Pro to Make Placemarks
and Measurements
While you’re examining Mount Rushmore imagery, you can set up some
points of reference to which you can return. GEP allows you to create points
of reference as placemarks. There are three points to mark on the map: the
top of the mountain, the amphitheater, and the parking area (see the following graphic for their locations).

Top of mountain

Parking area

Amphitheater

1. From the GEP toolbar, select the Add Placemark button:

2. A yellow pushpin (labeled “Untitled Placemark”) appears on the
screen. Using your mouse, click on the Pushpin and drag it to the rear
of the amphitheater so that the pin of the placemark is where the path
meets the amphitheater.
3. In the Google Earth New Placemark dialog box, type Mount
Rushmore Amphitheater.
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4. By clicking the Placemark icon button next to where you typed the
name, you can select an icon other than the yellow pushpin. Choose
something more distinctive.

Choose new icon

5. Click OK to close the dialog box.
6. Repeat the process by putting a new placemark at the top of the mountain where the memorial is. Name this new placemark Top of the
Memorial.
7. Zoom in GEP’s view tightly so that you can see the two placemarks
clearly in the view (with the two placemarks in diagonally opposite
corners of the view).
8. Next, select the Show Ruler button from the GEP toolbar:

9. In the Ruler dialog box that appears, select Feet from the Map Length
pull-down menu.

10. Use the options on the Line tab, which allow you compute the distance
between two points. The Path tab enables you to find out the total
accumulated distance between more than two points.
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11. Click the mouse on the point of the placemark in the amphitheater and
drag it to the placemark on top of the mountain. (Your heading should
be 310 degrees or so.) Click the mouse at the top of the mountain
placemark.
12. Answer Question 1.7. When you’re done, click on Clear in the Ruler
dialog box to remove the drawn line from the screen and then close the
Ruler dialog box.
Question 1.7 What is the measured distance between the rear
of the amphitheater and the top of the memorial? (Keep in mind
that this is the ground distance, not a straight line between the two
points.)

13. These abilities to create points of reference (as well as lines and area
shapes) and then compute the distances between them are functions of
a very basic GIS tool, which forms the basis for performing numerous
tasks that will be discussed in upcoming chapters. Chapter 5 introduces GIS concepts, Chapter 6 expands on how spatial analysis can be
performed with GIS, and Chapter 7 demonstrates how to take your
data and create a professional quality map of the results.
14. Use the Tilt functions of GEP to get a perspective view on Mount
Rushmore (as you did with the Badlands) and take a look at the mountain from a pseudo-3D view. Make sure that the option for Terrain
in the Layers box is turned on and also make sure the 3D Buildings
option is turned off. Although you can see the height and dimensions
of the mountain, the famous four presidents’ faces can’t been seen,
however, you can zoom or rotate the model.
Question 1.8 Even with Terrain turned on and the view switching over to a perspective, why can’t the presidents’ faces on the side
of the memorial be seen?

15. Turn on the 3D Buildings option. If you cannot see the separate
Mount Rushmore 3D model (which lets you see the faces), select the
Tools pull-down menu, select Options, select the 3D View tab, and
make sure a checkmark is not in the Use 3D imagery (disable to use
legacy 3D buildings) box.
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1.6 Using Google Earth Pro to Examine
Coordinates
1. Notice that next to the elevation value at the bottom of the GEP screen,
there’s a set of coordinates for lat (latitude) and long (longitude). Move
the mouse around the screen, and you see the coordinates change to
reflect the latitude and longitude of whatever the mouse’s current location is.
2. Zoom in closely on the road that enters the parking structure area of
Mount Rushmore.
Question 1.9 What are the latitude and longitude coordinates of
the entrance to the Mount Rushmore parking area?

3. You can also reference specific locations on Earth’s surface by their
coordinates instead of by name. In the Search box, type the following
coordinates: 43.836584, –103.623403. GEP rotates and zooms to this
new location. Turn on Photos to obtain more information on what
you’ve just flown to. You can also turn on the 3D Buildings layer (if
necessary, again using the legacy 3D Buildings option, as you did with
the Corn Palace and Mount Rushmore) to look at the location with a
3D version of it there. Answer Questions 1.10 and 1.11 and then turn
off the Photos (and the 3D Buildings option) when you’re done.
Question 1.10 What is located at the following geographic coordinates: latitude 43.836584, longitude –103.623403?
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Question 1.11 What is located at the following geographic coordinates: latitude 43.845709, longitude –103.563499?

Chapter 2 deals with numerous concepts related to coordinate systems,
reference systems, and projections of a three-dimensional Earth onto a
two-dimensional surface.

1.7 Other Features of Google Earth Pro
As noted earlier, you will be using GEP for several other labs in this book
and exploring some of these applications of geospatial technology. GEP
has a multitude of other features beyond those covered in this first lab. For
instance, if you had a GPS receiver (say, one from Garmin or Magellan),
you could import the data you’ve collected directly into GEP.
1. From the Tools pull-down menu, select GPS. You’ll see several options
for offloading information you collected in the field (such as waypoints) from the receiver into GEP.
Chapter 4 will introduce you to several concepts related to GPS, as
well as collecting data in the field and some pre-fieldwork-planning
options.
2. Close the GPS Import dialog box (unless you have a receiver you want
to plug into a computer on which you can view your data in GEP).
There are many other GEP layers and features to explore, especially
in relation to how geospatial data is visualized. To look at one of these
features, return to the Badlands once more and do the following:
3. In the Layers box, expand the options for Gallery and then place a
checkmark in the box next to 360 Cities.
4. Fly back to the Badlands and scroll to the western edge of the park, and
you see another symbol on the map—a red circle marked “360.” Hover
your cursor over it, and the text should read “Ancient Hunters Overlook.”
5. Double-click on the 360 circle. The view zooms down so you see a
sphere on the surface, and then the view dives inside the sphere. The
view then changes to a new view of the Badlands; use the mouse to
move about and look around a full 360 degrees. In essence, this tool
simulates what the Badlands would look like from that position all
around you. You can look in any direction, and you can zoom in or out
of places. Answer Question 1.12. When you’re done looking around,
click on the Exit Photo button in View to return to regular GEP.
Chapter 14 presents information about some more cool visualization
techniques for geospatial data.
Question 1.12 How does the 360-degree image of the Badlands
aid in visualizing the scenery? (Keep in mind that this image has
been tied to a particular location.)
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Geospatial technology is such a rapidly changing field that new advances
come quickly. Chapter 15 also explores some of these current developments
on the frontiers of geospatial technology.
Google Earth Pro changes regularly with new updates. Some of the
other options you may want to explore are Google Mars, Google Sky, and
Flight Simulator.

Google Mars
From the View pull-down menu, select Explore and then select Mars. The
view shifts to the familiar-looking globe, but this time covered with imagery
(from NASA and the USGS) from the surface of Mars. The usual controls
work the same way as they do with GEP, and there’s a lot of Martian territory to be explored. When you’re ready to return to GEP, from the View
pull-down menu, select Explore, and then select Earth.

Google Sky
From the View pull-down menu, select Explore and then select Sky. GEP’s
view changes: Instead of looking down on Earth, you’re looking up to the
stars, and instead of seeing remotely sensed aerial or satellite imagery, you’re
looking at space telescope (including the Hubble) imagery. There’s plenty
of imagery to be explored in this new mode. When you want to get back
“down to Earth” again, select the View pull-down menu, select Explore,
and then select Earth.

Flight Simulator
From the Tools pull-down menu, select Enter Flight Simulator. A new
dialog box appears, asking if you want to pilot an F-16 fighter jet or an SR-22
propeller airplane. Select whichever plane you want to fly; GEP switches to
the view as seen out the cockpit of your chosen plane, and you can fly across
South Dakota (and the rest of GEP). Try not to crash (although you can
easily reset if you do).

Closing Time
This introductory lab is pretty straightforward, but it serves to introduce
you to the basic functions of Google Earth Pro, and it provides examples
of many geospatial concepts you’ll be working with over the course of this
book. Chapter 2 starts looking at location concepts (such as various coordinate systems) and returns to Google Earth Pro to start applying some of the
topics you’ve worked with in this chapter. You’re all set, and now you can
exit GEP by selecting Exit from the File pull-down menu. There’s no need
to save any data (or temporary places) in this lab.
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